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void Mtr_Run_Iv (short mtl, short mt2, short mt3, short mt4 , short mt5, short mt6);
REULCRETE—YZLRE), WU UZERIEZDIREZRFTL. FIEEIC O Z5 2 DX TEIE LU,

SI¥L: E-SDHIEE
@) 22— (L=
Ox8000 22— (L=
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REFETQV&®RAKE : Ox8001 (-32767)
ROME : mo
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void LED(BYTE LedOn );
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O C S5
void BuzzerSet( BYTE pitch , BYTE vol );
B2, M1 —LDERE, TF-ZRSIEDSEZEM) 21— LAEERE

SI% : pitch : SROHE (0~255. BEHNAENFEENS)
vol : K 2 —ADEE (0~128)
ROE : mL

void BuzzerStart();
BRI5. TY—ZIBS LIE¥HD. BuzzerStop()BEEZEILSIE TR DT D,
SI¥: ®LU ROBE: gzU

void BuzzerStop();
=ik, JU—Z1tpHB,
S : wL ROE: ::: 30

5-6 RA1vyFAD (SW1)

AR—RICIE 1 DOBUNY YMEFH SN TNE T, NMAREEBHDOERMOZIB LS CETEEFITD
CENTRETT., Ea—FEIY 2 ZFERIDIHEE. COMYVEBICET, ESRAALEY—TYRZER
HY—bE8ET, Y-TYRZEBEPE. X1 yFANDEUTERTIETT,

O C SEEREH

BYTE getSW();
A VIRREES. CPU h— R LD UMY VY DIRREZES T D
ROME : O : off

1 © on

OmR—Fk  PIOO_1
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DT, MIMEEYUISRZET O IEHBE. PFTOT YT ANDERTERLRDET,

O C S3ERE#
UINT AdRead(BYTE ch);
AD ANBEE, A/D ZBOANBZESE,
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Sty /o 0 JENEIEE FoYRIL (01,2356 = S1,23456)
i =D& : A/D EHBDIEO0~1023)
O "=k
- S1 (chO) PICO_11
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+S3 (ch2) PIO1 _1
.54 (chd) PIO1_2
. S5 (ch5) PIO1_4
. S6 (che) PIO1_10
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— FO—=/N\—1% VS-WRCO03 . VS-WRCOO3LV [ZxT UIZ BV T T /N1 REZDFF M CESE I (E
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BYEDPFOTANTINA 2&E#H T DB, SEVOERRICH > TER LTI ES0N,

O EVEE
1pin  © +33V ER. TAIIVIHINY—F
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O C S5
UINT AdRead(BYTE ch);
AD ANBEE, A/D ZBOANBZES.,

S : FrIRIL (2346 = CN56,7.8
ROfE : A/D ZHBDEO~1023)
O R—*H
* CN5 (AN3. ch2) PIO1 _1
*CN6 (AN4. ch3) PIO1_2
* CN7 (ANS, ch4) PIO1_3
* CN8 (ANB. ch6) PIO1_10

5-9 0O0-FU—-IVI-FAHhK-F

COM—~FIE-YDOEIMEAET BN RO - —TYI—FHEDANDN— T, EEE D 7
b USTHE 4 BRETDCETIES « PEnDHBAEQGRHERET D ENTEET,

DEREEIIE—S 1 @m0 24 /NVA, BREED 611, I+ PED 12mm TIDT. 1 /NILRBED
/12[mm]ICZDET, Zl2L. E—YWMEY A VE 1 VEHEBBEITBEODHDEI DT, ERANRICK
DTCEUSAETERVNEEDBHDET.

Iva-—-4570avD

O C SR
void InitEncoder();
IV I—S#E8E
TV ID—SIRZEFERAITIMRC, INit)RIC 1 BLITRITIDNENHD
SIE I EL. ROE - #|L

void ClearEncoder();

IVI2—=5DU7P
ITYO-STHIYVEFLUTCNBDEZOICDIPTD
SIE I EL. ROE - 8L
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void GetEncoder(long *A,long *B);

TYIO-HERE. T3-S TAHDYEUTNDERESTD

S #A D S12RAI0NDY FERS I DIEZEHDINAT VY
*B 1 S34RDNDY EREITDIEHDINA VY

ROE : &L
O R—*H
+S7 (EE—H A PIO0_2
S8 (EE—4HB#% PIO1.5
SO (BE-HYAHE PIO2_11
+S10 (BE—-H B PIO2_10

5-10 IXBUS + UART (CN9)

COM— R, IXBUS 1hRENRD Bluetooth Y 2 —)U VS-BTOO1 &I DITHDIRIFTI,
Ea—ktEILY -2 TERIDHBEIE. BYTELUTI v+ O/IRE 2V TIREMNR— F VS-IXO01, 770
D ANDLER— F VS-IX008, 8 EIMMREY UM —F VS-IXO10 ZERIITENTE. VS-BTOO
ZEMIDEEFTIOISIVIEGTDOCENTEXT, XBUS #Eata—FEILY —2 ETHEATD
BEMUFTEREDDIP X1 vFD 3, 47%ZOFF ICUTIEEN),

VS-IXO01, VS-IX008, VS-IXO10 OEAIEINT 0~4095 DETHAHASINET,

IXBUS #hsRM— RIX DIP 21w FOREICKID 4B CABFICEHTESFHI. (UART (1 1#EET)

CEBTINISIVIIDHEE. INTON—ROERATEETT, (PYTILTIE EEEEHN— FDOHT
M=)

OoE V&
1pin @ PIO1_7 (TXD)
2pin © PIO1_6 (RXD)
3pin © NC
4pin © NC
5pin © PIO0O_4 (SCL)
6pin : PIOO_5 (SDA)
7 pn © +BV
8pin I +Vbat
Qpin : +33V
10pin : GND

OCE&EE# (IXBUS)

void i2C_init();

12 C #IEAIEREEL, IXBUS #2582 {ER TEDIAREIC T D,
SIEELU. ROB - F|U
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unsigned char Get_IX008(unsigned char Addr,unsigned int *retdata)

IXBUS #hsk— B (IXO08. IXO01. IXO10) N5 8 DDEYTANZEENS T DRI,

SIE:  Addr @ IXBUS #8807 F L RZHETE, Ox90,0x92,0x94,0x96 DUNFNOZIERE
*retdata : 8 DDDEYTFANBZERINTG DBIIDNA VS, 0~4095

ROME : ERBICZZULCEHESE1, KBULHE0

OC S8 (UART)

void InitSci3(uint32_t baudrate,BYTE parity ,BYTE stop);

UART #DEA1EESEL, UART #eEZBEMICL. M—L—k. NUFsEY . RbvTEY FREZERE

ER

SI#:  baudrate : BERHOR—L—FZEE. VS-BTOO1 Z2FATIHS 115200 &IERE
parity : /NUF 1 DA TZEIBE, T (odd) 1BF (even) F2lFx UL (non) &IEE
stop: AhvIJEw FOEY FHZEERE, 1 FEE2,

ROBE: #L

void SciByteTx(unsigned char data);

1\ REBREEL, TxN— 2B U CRIEBFIC 1 N1 DT —HEEEFETD.
S : data: XET—H

ROBE: #L

unsigned char SciByteRx(unsigned char *data);
1\ FZEBEE, RxIN— DS ZRESN/NY I PV TSNET—F%Z 1/\1 BT 3.
SIE:  xdata: FRIET—HYEZITID/NA FEHORA VY

ROME : ZE/NY I PHEDHE O, FITRET—HINEDIHRE 1. ROEN 1 DEZE UKITSCET, N

VI PHRNINTDT —HZ & L TRETED,
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5-11 #5RIO (CN3)
COMR—hE AR— RRTEEBLTIEN 0 K- FEZEHEIRIIERDET.,

2pin

OCN3 EVEE
1pn : P02 4
, 2pin : PO2.5
A=AATA 3pn : PIO2.6
4pn : PIO2.7
5pin : P02.8
6pin : PO2.9
7pin : PIO3.0
8pin : PIO3_1
9pin : PIO3.2
10pn : PIO3.3

5-12 LPC-Link ##i7/h— & (CN4)

COM—FIE. NXP 222385085 —XBOFHHMNR— K LPCXpresso BREICHEBLTNDT /N 7T
MLPC-Link ] ZEHM CEDNR—FTI, TOM—KIC NLPC-Link] ZEHEIDCET. BERERE
LPCXpressolDE T. F/\wZ (TJU—=OMA Y ~TOITOTSA—HEIE, V1 IVREIBDXED ., B
DRERIFE) ERTBEDCENTEBLDICRNET,

Om—k

1pin o +383v

2pin : PIO1_3/SWDIO
3pin : PIOO_10/SWCLK
4pin . PIO0O_9/SWO
5pin. : NC

6pin . RES

pin . +bv

8pin . GND
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6 BRRREDEACTYTILIOTSADET

ARIETIE [VS-WRC104] Z C SECHAY JRICERTRER. FEEMSNTD “LPCXpresso”
ZRVWCZYYTIILTOTS AOEGICEEUTESZ LE T, LPCXoresso sHIERDCRIABIFERTI N, &
DY0—ROBRICA—Y—NIY b EER. LBV T A ZDHRANDD > TNEIDT, VR R—)LiE
[CRY FDO—=DZRNBULHLIFEZ I IMBN DD LT,

FMR—RIEX T'VS-WRC103LV] EE#EY (—8EYOLERMENET) HHDXINDT. YVTILTO
T3 AIE TVS-WRC103LV] OBDZEFERLET, ZOREH. AXPICHNTE N'VS-WRC103LV] D
YU EERUTRHRELET,

RRINSFIBIIUTDEDTT,

D BRREOAF. 1VAL=)U

@ Y7oy oS oYO-R, EILE
@ TOUSLDEEAH

6-1 BIRIRE LPCXpresso DAZF

@ LPCXpresso [d. CodeRed (FsedD URL) h'6AF D YO—-RUEI, PO VDO—RICIEA-—T &%
MUBICZNDZET)
http://locxpresso.code-red-tech.com/LPCXpresso/

@ WEBXR—YZH L OJ 1 VEEMRENE T, LPCXpresso DA—Y—ND Y b EZHFHS TENEE
[& MCreate Acount] M VED UV D UL TPADY FEER LTI EE0N,
BEICPHADY L ERFESDAIR. R=IELELNA-F—-BE/XZD—-RZANDLT NLOG INJ DV
vy UT, ONDEHLTZSUN,

‘ username LOGIN || CREATE ACCOUNT | FORGOT PASSWORD? SEARCH I
I I ™
~
ravven e red
[—
~
dHNIEoTr> LT
,,,,,, ~ Vg
LPCXpresso powered by Code Red —
LPCXpresso is s full featured low cost development system for the LPC microcontrollers from NXP.
The LPCXpresso IDE is svailsble for Windows and Linux hosts. See the Getting Started Guide (PDF) for full details on system
requirements to run the LPCXpresso IDE.
Register here to create an account and download and activate your copy of the LPCXpresso
development tools:
| Create Account <
~
PRIV N !

FONISHTARIER
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http://lpcxpresso.code-red-tech.com/LPCXpresso/

@ PADYFDOEXTIE. MROXIBEBZADLTIZSU,

Create Your LPCXpresso Account
YOUR INFORMATION

First Mame* £

Last Mame* i

Address® X BN U BEDIEFR

City* BN

State/Region® BARS Japan EA
PostaliZip Code® HEES

Telephone® EEBS

Organization Name* PAIBUCV\DIEE., FREBLE
Job Title ADUBELSTEOK

End application market ADUBELSTEOK

{consumer, industrial control, automative, etc)

YOUR LPCXpresso ACCOUNT FREDI-T -8
Usermname® (PILD PRy F+8ZFT)
Emai* o X=JLPRLZR
Email (repeat)* X—=)L7 B U Rt#RAE

ADDHED S IZ5618T

@ TSign Up] &BITE, UMTDEDICRIASIN. ABDULCKAX—ILP RUZBICA =)L BEET,

Home

An email containing your login information has been sent to:

@
We have processed your details and an email with a tempaorary password has been sent to your
email address.
Important: IMPORTANT: Please ensure you can receive emails from Ipcxpresso@code-
red-tech.com. If you do not receive your email within 1 hour, please check your spam folder
andfor check with your system adminstrator to see ifthe email has been blocked. If you cannot
receive email from this account, you will not be able to login.
Login and change your password to a permanent one. You will also be able to download
LPCXpresso and register for your activation code.

Thank you for registering.

15



B UTDEOIBX—ILDEE. ERUCIA—Y—BOTIC/NRD— RORHNTNEII DT, ZN&FA
LC@QonBaNS0T 1> L TLIZEb),

Thank vou for registering LPCXpresso. You can now go to the Code Red Technologies LPCXpresso site and log in using
the following username and password:

USEMame.  sgddkiss

password:  sesksesdddw Co)j__-lj‘_gc\_—_/ﬁzlj_ |<‘

) ~
After logging in, we advise you to modify y _CDD‘{ V33 yunt link on the left navigation bar. You
will also have access to the user space that allow vou to download the LPCXpresso software and register for an
activation code.

Code Red LPCXpresso team
This is an unattended mailbox. For support or other questions on LPCXpresso, visit http://www.nxp.com
[lpcxpresso-forum

® OJ1>viLies, XR=IhRo 1 .Donwload the LPCXpresso installer for your host by clicking
here] O RICHD MDownloadl MAYY&ED w2 LT EE0)N,

Welcome I A—H—EhERENITT.

The LPCkpresso IDE is available for Windows (Windows XP, Windows Vista and V
Guide [POF) for full details on system requirements to run the LPCXpresso IDE.

If you hawve not yet installed LPCXpresso, follow these steps to download, install 5

17 Download the LPCApresso installer for your host by clidking here:

Downloads |

DUwD

16



@ D)y DFTRER=IBPODENDDT, ZONR—IH5 LPCXpresso for Windows] 2w L
T<rEEL,

A CPU M — R(E Windwos IBREBDHDXTIMES B TUVVERENWTRDET,

Home
LPCHpresso is available for Windows and Linux hosts. Clidk the links below to f

P . LTH g
m LPCHpresso for Windows

m LPCXpresso for Linux QIJ \yg

[Current stable releasel] WD UYDOZD) v O LTLIZEV, (UYDDXIXFEINEII I DT PD
N—=I3EaKRLEI)

D)y DIBDEFIYO—RMBFEDTT, T71ILDOY A IIEREICKENCH. FOV0—RIC 1 65
BRZENDDHZBENHDFXIDT. TEFRLES,

LEmwW I Nl Fisnmiesns e

If you are having problems downloading, try this link to download via FTP:

LPCxpresso w2.5.8 [Cument stable release]
LPCHpresso v3. 5.0 [Pravious releass]
5till having problems? Ty the LPCXpresso support forum

DYy HLTIIYO-R |
Attachment Size
LPCHpresso w3.5.8 [Cument stable release] 167.52 MB
LPCxpresso v2.5.0 [Build 208] 156.28 MB
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6-2 LPCXpresso D1 >R L—=)U

> 0— R U LPCXpresso Z PC [C1 VA~ —)LF DIFAIC DN TERBELE T,
SFOVO0—-FURAYRE=3 (exe 77 1)) ZFRTU. UMTRDFIRISOE>TA YA F—I)LEEDFT,
Fle. 1 YRAR=IVPICRY FDO=DICEMIDCENDDET, ZORIF. Ry FD—DEGFEHFI U THE
EaEDHTIZE0N,

XWindows D/N—=Y 3 VICK > T, HRDIEFTERDIBZENHDFT,

-EiEdl_lp =1
wr Welcome to the LPCXpresso
4\ Setup Wizard

This will install LPC¥pressa 3.5.6 [Build 234] on wour camputer,

It is recommended that you close all other applications before
PR ES SO conkinuing.

Click Mext to continue, or Cancel o exit Setup,

License Agreement
Flease read the Following important information before continuing,

Powered by
r_.code_red

Flease read the Following License Agreement, You must accept the terms of this
agreement before continuing with the installation.

LCB'I CODE RED TECHNOLOGIES, LINITED f’

hibtp: /fvavo nip, com/lpcxpresso

End-User Licence Agreement for LP CXpresso Software Development
NEXT Zz#89 Tl
November 2009

THIZ END UZER LICENMCE AGREEMENT ("LICENCE") I3 A LEGAL
(AGREEMENT BEETWEEN YOU (EITHER & SINGLE INDIVIDUAL, OR
STHNCTE 1FEGAT. FNTITV AND CODFE RED TECHNOTOGIFES TIMITED T

¥ 1 accept the agreement; Pt
...................................................... i |
9: TwWv { 735 = Idonot accept the agresment

WG 2

http:f s, o, comflpexpresso < Back I Mext > I Cancel |

o The folder: NEXT E?qag—

C¥nxp¥lpoxpregzeo_ 35

does not exist, Would vou like the folder to be created?

i [, \i l:ﬂ:' | -Eietup =L

Debug driver selection
Please select which drivers to install,

(IUV\EHT

‘Windows may issue warnings when installing these drivers.,
If prompted, please allow the drivers ko install,
Drivers are located in the "Drivers" directary of the installation

¥ ‘Code Red Debug drivers
[V WP LPC-Link drivers

YA 2

bkt S, iop. comylpcxpressa < Back I Mext = I Cancel

NEXT &89
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Select Start Menu Folder .
where should Setup place the program's shortcuts? '
Setup will create the program's shortcuts in the Following Start Menu Folder,
To continue, click Mext, If you would like to select a different Folder, click Browse,
Browse... |
Select Additional Tasks .
WEIGIE, 234 ‘which additional tasks should be performed? s
bitkp: s rip, comflpexpresso < Back I pewt = I Cancel
Select the additional tasks you would like Setup ko perform while installing LPCxpressa,
then click Mesxt,
& For all users
' Far current user only
Ready to Install .
Setup is now ready to begin instaling LPCXpresso on your computer, i
3 G 2
Click. Install o continue with the installation, or click Back if you want o review or Rkt s, mp. comyflpoxpresso <Back I et > I cancel
change any settings. — —
Destination location: -
Ci¥nxp¥lpcxpresso_3.5 N EXT E;$ g,
Start Menu folder:
LPC¥presso w3.5
Additional kasks:
Additional icons:
Create a desktop icon
Far all users
Install drivers: :
Code Red Debug drivers - Installing A
LI » Flease wait while Setup installs LPC¥presso an your computer,
S| ety
< Back Tnskall Cancel | Extracting files. ..
C:¥nxp¥lpcxpresso_3.S¥eclipse¥ijre¥bin¥igs. exe

bbb e, meep. comylpcxpressa

Install =9

T LOEEIShED, VAT L
E%‘i—' AlFE . TERC o] S

90 SHCA AL EPIRL. VI TP A FCEELT

1AM ERITLES
T EELEDRY. A

Windows O IOZET A SHLEVIMITPEAT dackE.
Microsoft FE{HELE T,

(|

5EIETHD

A5 2

http vy, mip. comylpcxpressa

EENMYERTSNBCEDBD

FIDN EEHDIEADT,
INT MEf7] 2BUET,
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Completing the LPCXpresso Setup
Wizard

Setup has finished installing LPCXpresso on your computer,
The application may be launched by selecting the installed
icons.

PRESSO

Click. Finish to exit Setup,

V| LPCXpresso Getting Started

Powered by
r—_-code_red

btk fan, rip, com/lpcxpressa

< Back I Einish |

M ET. LPCXpresso D1 VA +—=)UIZ5RT T,

20

Information
Please read the following important information before continuing,

PRESSD

‘When you are ready to continue with Setup, click Next,

[ PCxpresso (powered by Code Red Technologies)

Release Notes

(Linuzx - all includes updates as for latest Windows release)
v3.7.6

- Picked up all latest Windows fixes and updates

v3.7.5
- Picked up all latest Windows fixes and updates

v3.7.4
- Fixed more problems with Mew Project wizard

v3.7.3
- Fizxed header files For newlib, Both newlib and redlib can now be used. LI
Y3 GG e
bt fvwe, nixp. comflpexpresso

Mext = I

NEXT 189

Finish Z#3 &,
LPCXpresso H'&&81Lxd,



6-3 LPCXpresso DicE) & 5035E

RIC, LFOFIEICTE T SWEHFRZITNE T, seFECTIEA YA E—)LURE PC Z+1 V5 —Ry ~TE:
LUTND, FEE 1Y —Ry FCEH L TNDBID PC HIUBICEDHDFT,

@ LPCXpresso Zi#8ILEd, BEMIDICIE. TRAORYTEOPAIVESTILD ) wDT DD, RS
—rXZa2a—DOINRTOTOTSAKD TLPCXpresso vxx] > [LPCXpresso vxx] Z21)w2 LT
<fZ&W, GKZIEr VX =)L LTz LPCXpresso W/ N\—I 3 YW EFTANDZEI)

@ BIFIDEUTOBEINRRISNET,

\ V¥ 4
A g8
PRESSO
Powered by &code_red
ENNNEENEEENR

@ WAZTOTCVWVBENEMUTDRIBRAINSNEIDT, OK ZIBLET.

License type: UNREGISTERED (Code=1)
!E Debue limit: 8k
Activation code: not available

To request an activation code or to activate a licenze, pleasze select
Help=>Product Activation

Licenze Restriction:
fn UMREGISTERED copy of LPCHpresso may only be used for
evaluation purpozes.
Register and activate to remove this restriction, OK E?$§-
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@ HEEFIDE. UNOREBEARTZSNET,

Run

Windon  Help

[ i Jg-E- 2/ |SSEH |uGBOLE I =k-lsw || el s £ A& Develop
[ Project Ex 52 it Gore Regis | & Peripheral | = O[3 Weloome 53 =g
=l 8 & [l /G /rp Tpcxpresso_3b/paees negisteredhtm = &
b ' PRESSO
A powered by E-code,red
Please note: Your product is not activated
AN unactivate Evaluat Register and activat
Activating your product
taina I
act
() Quiskstart 53 . (9= Variables | % Braskpoints| = O 0
~ Start here 2 = |
& New project. ~
@ Import Example project (=)
b Build all projects [
& Build" [ o
& Clean " [
# Dehe [ v . =
cbue
oo ) Consale 58 |1 Prablems | (] Memory | (I8 Red Trace Previen | s E-r5-=6
(3 Quick Settines - Na consales to display at this tims:
- Project and File wizards v
~ Import and Export ¥
** Build and Settines ¥
=

I R-JtETENELE

B W=)UN=DANILTH 5,
F9,

Help >Product activation > Create Serial number and Activate... Z&

indow | Help

€ oG {7) Help Gontents
@5"' Search
Dvnamic Help

w

|
sl

kew dezist.

Tipz and Tricks..
Cheat Sheets..

Citr [+5Shift+L

Product activ

Support

Inztall Mew Software...

| | /A - | %

presso 00/ pagesunregisterad him

FE<

" Digplay licenze type..

Pl

Enter fctivation code

About LPCHEpresso

3 |dperade your product

S |

I

® RASNLEIYIPIVTIYN=ZEXE, JE-TFDIBELT. —BHICREFELTRE, OK 2B LI,

Create Serial number and Activate

Select O to vizit the regiztration website where vou can
regizter vour product and receive an Activation Code.

]|

PRESSCY

JUPIVFTIN—ZEAXELUTREFT,

Serial number || ok R ok I R e L G R I R R O R L R S L S L R R S L L

[T Open in external brovwser

¥ Copy Serial Mumber to clipboard:

FzvOUET

Cancel I

OK ZLE g

22



@ OKZ®I &, UTFOOT+ YBENBEEET, 1 YRAF—3&5DY0—- R UEKRICERULCPADY
FOd—Y—-8. NRDO—FZ2ABDL. OTJ1YULET,
(OT4 VEHDEBES., ODBENREIEINT, @, GRIRIEILET.)

username

Home My Registrations

@code_redm 5P

My account
Log out

.OGIN CREATE ACCOUN FORGOT PASSWORD?

LOGIN Z&#9

Support Knowledgebase : Downloads

Blog | Support Knowledgebas i Downloads

Home

X

WFHYIN—ZAD

My Registrations )

Enter serisl numper hars
I. *.”?if:"f-_“"f_*:kzk-.*“"Eif*_-;?'fif*if:*?s*.*_;**.**r*?’f.**:***.*-if*.“’iif_-****

| Send me my activation code |

Send me my activation code &9
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M VEBTE, UMTROEIDICRIIN. PHIY REERUIZX—ILP RURIC lactivation codel
DEE SN E X—)LH BEFET,

My Registrations Bllil‘l Support Knowledgebase Downloads

@code red | 5 s

Home

My account
Log out
Your activation code has been sent to the email address for this account

{ XXXXXXXXXX@YYYyy .com).

Please ensure you can receive emails from Ipcxpresso@code-redtech.com, and check your
spam folder, in case you dont receive your code

Thank you for registering LFCXpressa.
Return to Home FPage or Register another product.

@) Help>Product activation >Enter Activation code =2 ) w2 L. POTF«X—Y 3> 30— RADE
BZEBE=ET,

‘B Search
|| Dynamiz Help
e kKey feszist. Cir +5hift+L
1=’=f> T ce) Trids preszo 36/ pages/unregistered htm
Cheat Sheet=..

Product activation " Display license type.. <
Support ¥ . Create Serial number and Activate..
Install Mew Software... - Enter Activation code

About LPCHpreszo 3 Uperade vour product S

I

1 E X—=)UICEeEDH D lactivation code] ZAHDULET,

Enter Activation code

Bctivate vour product by entering wour Activation Code PRESSOY

Activation code |****_****_****_****_****_****_****_**** |

E X—)UTREL\Z
activation code ZA NI D

] 4 I Cancel |

OK Zz#9
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M FEINERICTTIDE. MFOEDICRRAIN. FIRHNEEFSINE T, OK =B LE T,
]|

- Licenze tvpe: FULL

Debug limit: 128k
Brtivation Code: % s -dededede _dededesde e sente Lo ok e L e e e e e e e

& FULL copy of LPCHpresso may be uzed for production.

OK Z1#89

IM ET. LPCXpresso DREHEEIIST T T,
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6-4 YVIILTOIT I DA IYR—-FEEILE

WKWK CEBYYITINTOTSAZEFHHAH. CPUNEZAHET, CCCTERIDTYTIILITOTS
LI BEEREETOLCRREDTOIY D FEMTY Y IV ERH L TNEIDT. MUY IILTOYT I ]
EWUVFET, MFOFIBICE>T,. UYTILTOI D DA UR—~EEILREZET >TSS,

(1) D=DAR=D A IWITDEE

LPCXpresso &2+ VA —)VUZKRIC. UTDIBFAICIREDD =D IR=AMESNFT, COESE, 1
—Y-BICE2AXF (BFRERE) H'EINDEE. ERICEIRFTEFEANDT, D—DZAR-T 2
SFNEBZET>TIREEL),

* WindowsXP D&

C¥Documents and Settings¥[1 —1'—&X1¥My Documents¥lpcxpresso_3.5¥workspace
» Windows 7 D&

C¥Users¥[1—t —&¥]¥Documents¥lpcxpresso_3.5¥workspace

1 —Y—8IF Windows ICOZJ1 > L TCWNWB1—F—& T,

X EESRBANRSODSRNES. UMTFOFIRTI =D RR=R I A IIDEE =T >TIES0,

@ LPCXpresso DI 7 JULX_a—hH'5 Switch Workspace > Other...l] Z2RUD'J v D LET,

File Edit Mavigate Search Project Bun  Window Help

Mew Alt+Shift+h  » J = S |—£I<> E
Open File,. . .
=
Ciloze Citr [+ heral 1 = 0
Cloze All Ctrl+shift+y
= <}§} =
Sawe Erl+s J
Save O,
Save &l SirlEshitt+s
Bevert
Mawe..
Fename.. Fz
2| Refresh F&
Cionwert Line Delimiters To 3
Erint... Etrl+f

Switch Workspace

Restart

Switch Workspace > Other...

g Impart. pointz | = B
a0V

75 Export.

Properties Alt+Enter

1 Welcame [Welcome paze]

Exit

I
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@ T[Brows...l 22w UZET,

!Wnrkspace Launcher x|

Select a workspace

LPCrpreszo stores yvour projects in a folder called a workzpace.
Choose a workspace folder to use for this session

Wark space: IO:¥Dcu:ument$ ahd Settines¥demo¥My Documents¥lpoxpresso 3 5¥morkspace ;I Browse.. |

» GCopy Settinegs

Browse... 22w o
@j 0] 4 I Cancel |

@ ¥AIVEaA—FRD IA—RILT 1 RD(C)>nxpl T #ILIEERL. TFHUWNI 2 LI DR MY
VD )y D UET, fERSNE MHULWI 7Y 1 OEFIZE Tworkspace] I[CEELFET, OB,
HNIFFBRFTADLUTIIZSHN,

Select Workspace Directory 7] x|

Select the warkzpace directory to uze.

(& FADbe? -
SRSV
SR I W R
Bl Gee O—=HL T2 G

) AGENDA

) ARVEL

I Brother

I Documents and Settines

I My eBoaks
I My PageManager

, g My Skype Pictures— | 5 o1 LS8R
r|::-::|:| =
R expressn 95 21|

I OfficelUpdate orkzpace directary to use.
== PeCatin LI
p2al S = R
: . e
LTS OUERR M) | ok | wetn | | opils
——Ené O—hll T80 G
M%7 LU\ D )L DYEEK 5 AGENDA

EBY ) ARVEL

Iy Brather
I Documents and Settings
I My eBacks
I My PageManager
[ My Skype Pictures
= ) nep
I lpoxpresso_35
[} vork zpace
272 IL5EBIC : TP Mfieal Indate d

l'workspacel E¥HTAD Tl LT

LA OPERM | ok | weutn |
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@ COFEFETIE. TAINAIDPRMEINTUVZENDT, I A IS BICERE Tworkspace] EANTDH. MU
TOFIET., —ERIDIAIAIZED ) v D URREIC. BE Tworkspacel 22L& D v DL, D=

L&D Tworksoacel [C/8>TUWBZ EEER L. TOKI MY VEBLET,

Select Workspace Directory

21x]
Select the workspace directory to use.
=l s O-A) 720 G |
[ AGENDA
= ARVEL

I3 Brother

|3 Documents and Settings
I3 My eBooks

() My PaeeManager
) My Skype Picturss nxp 2 7 LY ZEIR
=l ) nep

H Ipu:xpressu:u 35

B Offlce,_,date workspace 7 # LS &R
I PeSetup

|3 Program Files

== Razdma j

T I Iw::nrkspa-:e workspace [C/X > TCNDC E&ET#ER

[ #rLL oA e | ok | Feba |

Ve
oK1 MY V&Y

Bworkspace 7 # LD TC¥nxp¥workspace] [C/Z>TWBZEEER L. TOKI MY VY =EIBLET,

-'lll'urkspac:e Launcher x|
Select a workspace

LPCHpreszo stores your projects in a folder called a workspace
Choose a workspace folder to use for this session.

Wiorkzpace: IG:¥nxp¥wurkspace

» Gopy Settings FC¥nxp¥workspacel ICE>TU\BC &R

©,

] | Cancel |

[OKJ hY V=89

MET, D=DZAR=D# VI DEELTTTI,
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@QvYINTOID D1 VYR—
RICD=DIAR=R(CHYTINTOI D b+ ViR—FLET,

@ MFD URL &D. Ea—F=Z ARM BIR—=R=IJICPOEI L. LED RIFY>YTILT7OY D~
N'VS-WRC103LV_Sample_LED_xkkxk zip | Cekwk(3/N—T3>) ZFDYO— R ULET,

http://www.vstone.co.jp/products/beauto_mini_arm/download.html

X YR—R=ITRHELUTNDEDDEHICEDEIN. Ea—FZZ ARM D CD-ROM ZHFHHD
=, CD-ROM R TC SEB_ARM¥T Y TILTOY D ] IAIIFRICE. YV TILERBHL
TWNET,

@ Zip D PAIWEBREULZ D AIWASED—DAR=2 D A)IICIE—LUFET, 1) TIT—DZR—=2DT =)L
NEZELUIEBE. [C¥nxp¥workspacel [CJIE—LUET,

o1

| Zr0E REE RTW BRCADG w0

|OF2 -9 - | PrE o & X 7

| PELAD? ) C¥nxp¥markspace - aEh

.metadata import. log

Workspace 22 )LYIC. Zio D7+ IV
BELUTCTERIAIWIEIE-TD

1 {BDA I 10 bR | g 7 JuEa—A 4
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http://www.vstone.co.jp/products/beauto_mini_arm/download.html

@ LPCXpresso Zi2&@) L. BEZL FDQuickstart Panell D lmport and Export] &k D lNmport existing
projects] ZBE=E T,

ll port exisiting projects %89
[:L Import files into "WS-WRC103LW sample_LED

‘EI Export projects to archive ‘zip!

‘EI Export projects and references to archive Gip)

Eug Smart Import wizard

Imiport estsiting projects
Salect a direchory 10 sanch for existing Eclipse progcts.

Browse Z##9
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® YYTIINTOI D REREFELURZ. D—DZAR=T# )L (C¥nxp¥workspace) &EIRL, OK &
BLET,

2 x|

Select root directory of the projects to import

(@ Fabtet -
) 74 kb
= P I8
E = 0L Tr20 ©2
) AGENDA
5 ARVEL
|C5) Brather
|5) Documents and Settines
) My eBooks
I My PageManager _ o .
[ My Skype Pictures 0 92/\ A Z)bgélg;R
E (5 nxp
|5 lpoxpresso_35

ace

o e Affical Indata LI

FoA L4 Iworkspace OK E;qag—
FLUTHIADIES | ok | st |

4

® AYR=FF2T0YTD L (CTTIE N'VS-WRC1O3LV_Sample_LLED wksskkork_stoksok | (oot
VIWDN=I3YVOEFHADET)) ZF Ty I L, lFinishl ZBLET,

ol

Import exisiting projects =
Select a directory to search for existing Eclipse projects. E ;

(+ Select root directory: |C¥nxp¥workspace

= Select archive file: | Browse.. |

Projecta:

----- VE-WRCT03LY Sample LED 20101207 1545 (G¥nxp¥workspac Select All |

A IMR—+9RTAOIYTOREFTYD Dezelect Al

Refrezh |

1| | 0

|v Copy projects into workspace

Finish Z#89
@::l Einizh I Cancel |
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@ [Finish) Z20Jwv292%&, BEAZLD Project Ex) ICT7OY 0 ENENEY, CnNTJ0Y
I FDFHIAHEIFTTTI,
SIS LR L
KLr_‘, Project Ex &3 W Core Regis\l =, F‘eripheralw = Eq G

=
= ‘_5 EUS—'I.I'I.I'F{G'I 13V Sample_LED 20101207 1545
--qf;f‘ Binaries
+Y—0E@FETOVTY || F i) holudes Src DA LT
FAERBCENTEFT. B sre EEDY-—2T P IDBOET.

-|g| cr_startup_lpcl3c
lg| epio.c

c
lg| xbusc [
g mainc

- g we—wrc1 03
= Debug A
[& Releaze
[5; i
-2 lib

-~ : . - (==
V) Guickstart 23 (%)= Variables | g Breakpoints 8

o = . [ = | - (] e |

QU rIINTJayz O nEILR
RIC. TOTS L% CPUM—RICHRICERIDIEEDOLEIL FZEFTNET, UTOFIBICHK->T, EILE
Zi7oT<IEZSELN,
@ T[Project Ex] TEILRLEWVWTOY Pk (CCTTIE VS-WRC103LV_Sample_LED) ZEFEIR L.
Project>Build Projecrt 22w 2 L CE)L FZERIBLE T,

- Develop - Welcome page - LPCHpresso
File Edit Mavieate Search | Project Bun  Window Help

_ . (e Frajest
= - - - = \‘
J o | HL J (G Cloze Project J =
- - (:::] - - .
- o Build All Cirl+B
L[ Project Ex 3 atni Gare Build Configurations b [come 23
Build Project
=] | 4
_ Build Working Set vf ® <
g - e Clean..
Eijpe -2 Siriaries Build Automatically
el Theludes

EILETD 519 -~ Properties
JOYTU FEER |

|l cr_startup_lpcl3c
- Bl epioc
 Ebg] ixbusc

f R lel maine
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Q@ EBEILRZEREBIDEUTDI A POTHRRSINZINDT, TIIDETHHEI,
- Building Waorkspace

Inwoking Gommand: arm-none—eabi-gcc —E.insfore eclipsecdt makecore/specsc

[ Blways run in backeround:

Fun in Backeround I Cancel Detailz =»

@ FTTIBDE F1POTNEL. MFDXRIICKRRSNET.

|| # our products' serial number will be displayed i | |
fE Conzale B3 B Prublems} i Memnr'ﬂ " Red Trace F‘review} A EN | e Bl - T 5
C-Build [5-'WRCI103LY_Sample_LED_20101207_1545]

WVI-WRC103LV Sawple LED 20101207 1545.axf; arw-none-eabi-objcopy -0 hinary LI

WVI-WRC103LV_Sawple LED 20101207 1545.axf VE-WRC103LV Sawple LED 20101207 1545.bin;
checkswn V3-WRC103LW Sample LED 20101207 1545.hin:

text data hss dec hex f£ilename
2753 u] 4390 3243 cab VI-WRC103LV_ Sample LED 20101207 1545.axf
text data h=s deg hex f£ilename
_ 2753 u] 4390 3243 cab VE-WRCI03LV 3Jsmple LED 20101207 1545.axf
. -
J J WE-WRCTOALY Sample LED § MEP LPCT343

% CCTError BEEBE. 1) DD—=DZANR=2AT A )V DESN IERBICTATENWTREED BV FT,
BED—=DOZR=2ID A )V DEEETHO>TLIIEE),
GhLWDI )L DEEIEZEE T, Tworkspacel EANTBEEIFIUTFEBTADLUTLZELY)

% CESBOY—RERELLEIC, Error ERRENEBESONWSER [6-7 TS—DEE] ECSETF
ét]\o
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6-5 VS-WRC104 \NDTOT S5 LADEEAH

BN TOYI D REEILETDE, D—DAR=RT ALY ¥ VS-WRC103LV_Sample_LED
¥ Debug AIC. N'VS-WRC103LV_Sample_LEDbin] EW\DD 7 JLAYWERSNE T,

COI7AI)IL%&E CPUNR—RICEZATE, FRULETOTSA%ZE CPUNR— RICETSEDCENTER
DT, UFOFIRT, SSRAHETo>TIES0),

@ USBZT7 =T, CPUM—FDOETHOERZ OFF ICLET,

@ TyYamPVaEBUIEEX. PCEUSBT —JILTE#HLE T,

@ USBZEMULIZSTyYamIVIEEELTE OK T,

@ 20MWIEER/DOE. PCHCPUM—RFZUSB XEUREECRU VAR U —=IF /N1 R EU TS
LET., (T CPUNR—FZPC ICEIULHRS. @#EIC UIESBENDDDET,)

3) USB =i LICORET

2) USBT =TI E&ELiAD

® CPUMR— RN PC ICERBIcNDE. TCRP DISABLE] EWSEBMOD RS+ TJ&TRRSNET, CPU
M—FZEEHUCS VI VEa—-F ] 28T COBMD RS A INRTSNDCEZERL. &
INDV)y D UTRSATEBEEET,
N—F T8 F347

S AL #0356

VL-RTNZEENELT A

_ DVD-RW 347 (D) QQ GRF DISABLD (E2

e
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©® [CRP DISABLEJ ZBE< &, BT Tfirmwarebinl EWD I 7 1IUA—DA>TNEI DT, DD
71 ILEBIFRLUE T,

= CRP DISABLD (B

| HE REE BTV BROOE y-MD P

Q-0 -0 De= [T ||§ °

| PELAOY |- pu =| £ 1z8h

Elll R

@ D=DIAR=T#)LF ¥ VS-WRC103LV_Sample_LED ¥ Debug MM,
N'VS-WRC103LV_Sample_LED.binJ Z3E—LT. CRP DISABLE. RICR&D{HIFET,

& Debue !IE E
| e REE FTW BROOVE YLD AIH |

Q- F| Je= s || (3 X

| PEVAD) |5 1 25¥morkspace¥VS-WRG103LY Sample_LED¥Debue =] (£ 158h

>

— =l
ve—wrc]1 03k _Debug_mem.Id
gag LD 27 )
223l | 1B
== CRFP DISABLD (B2
] VSTWROT03LY Sample LED.axf | VP RER RTW BRLAN@ U@ 2 G
FH EHIiF K__)I'a?’fJL-

J GEE) T IJ - L.‘-ir | .!".-j ﬁi j?'”bg ‘ II$ -
C103L Sample_LED bin

e s | PELAD) [ £ B
SR U5LY Sample_ LED bin

VE-WHC1D3L3 Samnle LEM man FDT4 Data File
3 kB

MAaP Pl
91 KB JE-93

BED1IID
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® PC D5 CPUM—RZERDAL, BESRZANDE. ESRAARLTOATSAICHK >TCPUR— RHE)
ELET, LED YT TOTSADESAHNERICT T LTNDE, ZL VY, #&D LED H3RZEIC

RUTLUET,

(
L4 ver.C

US-WRC104

ULW.VSTONE.CO. Jp

LEDL YY) LEDHR)

S eeres—— e

BI35TT T,

MET, TJOTSLADESAHFI
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6-6 LED®@MIOTSAICDNT

YTV LED R 700 S AR BEE LED(. Wait)’2EZEE>T LED ZHIfHLCWET., TN
BN YS D 7 1)U VS-WRC103LV.h R TEZESN. OIS ARTRBIDCENEEET,

LED RIB700 35 A0 main(BEHEURNICHUET, TOTSAZRITIDEE. TTFCD main() BEE
NHEERITEINZT, LED 70T S5 ATIE main(dledc RICHDFET,

1. void main(void)

2 {

3 //HIEBRBDRE (81 Hz & 30.07]
4. const unsigned short MainCycle = 60;

5

6. Init(MainCycle): //CPU D#EAFRTE
T //12C_init(void): //IXBUS #5816

8

o /=T

10: while(1){

11: LED(). //#&D LED RXT
12: Wait(1000);  //1000msec 5D
13 LED(2). //ZLYIDLED RKT
14: Wait(1000);  //1000msec 5D
15: }

16:  }

main BEEDETIC DUV TERBELE T,
O = (D)=
A4~T . SHEBEDFIEARTE
8 XA U)I—=T
while X TENNZERIL—TRICET LIz WEZESER LE T,
O~12 . {79 DB
LED(B8%E Wait () BEEZERIA L C LED ZRAEICRABSIE TNET,

ZREMICDONWTIEI AV Z2APILOSE FZEY Y TILT7OY T FROA VS I 741 )Ulvs-wrc103lv.h]
TEBEICHRELUTNEIDT, ZE5EELIIZE),
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6-7 IS5—DELE

YYINLTAY O EDTOTSLEEE L, LRI DIEBXDOBENSETEIV RIS —NRETDICE
DHDET, Z0HE. MTOFIET, TS5 —DFREUCERZEER L. BELTIES0),

OTOTSACIS—DHorBE. IVY—IUCUTRORIDEE I RIEREHNARTIINFET,
Error DEOEUBEIZ. W DIS—D'HoEDZDENHNRISNZET,

Wait (1000); //1000mseci7F]

E Console 3 . &/ Problems} a Memorﬂ & S&arch} 8g Breakpoints} o Expressions\l )= Variableﬂ 2o Call Hierarchy\l

C-Build [WS-WRC103LV_Sample_LED] & |__-='||| = R b
arm-none-eabi-gce -D_ USE CMSIS=CMSISvilp30 LPC13xx -DNDEBUG -D_CODE RED -D REDLIB .|
-I"C:/Users/yokoyama S59/Documents/lpcxpresso_3.5/workspace/VS-WRC103LV_Sample LED/inc"

-I"C:/Users/vokovama S59/Documents/lpcxpresso 3.5/workspace/VS-WRCL03LV Sample LED/1ib" -00 -Os
-mword-relocations -g -Wall -c -fmessage-length=0 -fno-builtin -ffunction-sections -mcocpu=cortex-m3 -mthumb

-MMD -MP -MF"src/main.d" -MI"src/main.d" -o"src/main.o" "../src/main.c"

../e2rc/main.c: In function 'main':

fare/main £:122: error: expected ';' before 'LED' |E| F Wi
make: *** [3rc/main.o] Error 1 —
f -1 fwor
PC1343 )
S Ly I LIl - L TII SoL'7 I LIl.d O ooy Inall

ILF L I
q"ﬂrc..-"main.c: In function 'main':
— igrcimain .22 error: expected™' IS-—0#H | 'LED'

pusy

make: *#* [src/main.o] Error 1

QIS—DBZERIDLEHICIE. Problems] YT EEIR L. Errors ROWFNHDIS—&ESFT)ILD
Jw2D3ddE IT45LET. IS—EBRNRISINZET,
L0 A BB w5k ks kR R R R R R

int main (wvoid)

{
£/ HIENEBADERTE (E i nz $E: 30,0~ 3
const onsigned short MainCycle = &0;
Init (MainCycle) ; s/cPul f1EAERTE
£
while(l){

20 LED(1): //#HOLED - S - —

21 Wait (1000) /. 3) IF«FICIS—BANLRTIEIND

22 5

25 Wait (1000); //1000mseciF i

24 H

25} &

4 2
El Console [[£i Problems &2 @vemory | 47 Search| © Rreaknaints| 1 Fxnrassions | 69 riables} e call Hierarchﬂ ¥ =g
2 errors, 27 Warnimgs=8 olivers 1 ) Prob]ems E%?R
. Resource Path Il

Description
(M

4 © Errors (2 items) 2) Errors ADIEBZES IO U YD

| @ expected ;' before 'LED' — "103LV_Sample
@ make: *** [src/main.o] Error 1 VS-WRC103LV_Sample_L...
4 @& Warnings (27 items)
flash.h /BeautoRoverARM_firm _

& 'call_IAP' declared 'static' but never defined
UL |

3

< |

'C1343
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QT CTHIS—IE LEDR2):Daiom Wait(1000 )i T (2=230V) 1 HBRNCEICKDEDTIDT.
ZCEBIEUTBELEILFULET,

int main (wvoid)

J/HRENERAD R E (B 5z #[H:30.0~]

con=t on=igned short MainCycle = &80;
Init (MainCycle); //ceul T EAEEE

FE=1
while (1) {
LED (1) ; /AR LEDS LT
Wait (1000) s Ommeei® )
LED(2} :
Wait (1000) ; Hlmunsecﬁﬁ

DIS—DE<BD, EBCEILFDRTTIREUTORSICRNSNET,

e R EoN |- R N

12int main (void)
134
/RN ERAD 58 (A 5z #E: s0.0~)

const onsigned short MainCycle = &0:

Init (MainCyele) ; / fceuD#EAER E
FA=2

19 while (1) {

20 LED(1) ; /A FRMLEDS T

21 Wait (1000); //1000mseciF)

22 LED(2) ; S LD LED S AT

23 Wait (1000); //1000mseci¥)|

24 }

25}

4

El Console 33 [ Problems} a Memorﬂ & Searchw Sg Breakpointﬂ & Expressions} 4= Variablesw T3 Call Hierarchﬂ
C-Build [VS-WRC103LV_Sample_ LED] @, Bx| ot

arm-none—eabi-objcopy -0 blnary V5- WRClD3LV Sample LED.axf V5-WRCLO3LV Sample LED bla checksum
V3-WRC103LV Sample LED.bin;

Cext data bss dec hex filename
2753 0 490 3243 cab VE-WRCLO03LV_ Sample LED.axf
cext data bss dec hex filename
2753 0 490 3243 cab V5-WRC103LV Sample LED.axf
| Smart Insert ‘ 23:33
201343

MET, IS5 —DEBIEEFTTTI, I7 1 FICKRT UCEICEET DB CHBMEC > TNDTREME
HOFIDT, ZORICEFRLTCIS—ZBIELT UL D,

39



WATY3aVN=Y, BEEROCHEAL . » -
No.1 OBHZ ! BBFTY3V/N\—v, ORy ~ESERROCEARIFS

http://www.vstone.co.jp/robotshop/
BX » Amazon * Yahoo D& Web 588, FIZERR. BADZONyY bzYH—/EEETEOMNY ~ESE
BeZREVRDUEEITET,

Oy FEVS—RRUERE BRSSOy M2ys—DR2D IPE(EBRE)
+101-0021 814-0001
ERBTROXNSE 1-9-0 WALIL AF  EBTREXGESR 2-3-2

TNG B%288 2F ORZ O T PN
BROXMSCERIL. RHRE « IR « CERDKREREZTED EX—)LICTHENEHELIZS),

E-mail: infodesk@vstone.co.jp SH™ 1 1000~17:00 (XBRBIFH)

T4 A~ URASH

T555—0012 ABrmheuiE) I XEHEBS 2-15-28 VSto n e ®

TEL:06-4808-8701 FAX:06-4808-8702 www.vstone.co _] p

40



